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ArahWeave 8.4m January 2019 to 9.2d June 2020

Enhancements

In jacquard conversion, added shortcut for gray-scale conversion: Shift + Ctrl + G

In display of warp pattern in user interface with letters A-Z, use | character to indicate that yarn is used in selvedge.

Added <CreationDate> to the exported XML file, so user can check if a newer XML file was sent, and import it again. 
The values are year.month.day hour:second
<CreationDate>2018.12.30 20:27</CreationDate>

In save cards for production, in files menu, added a function to read loom layout from a fabric file, in case that fabric 
file also contains loom layout. This function is only available, if user saves loom layout in the fabric file.

If you pressed shortcut key [Home] or [End] to reposition fabric view, ruler was not redrawn automatically.

Inverted order of * and | in yarn letter display, since information about used yarn is more important than information 
about used selvedge yarn.

Improved GUI diagnostics on import of the following XML files:
yarns, yarn to color, yarn colors, warp and weft patterns.
Program now displays in popup message the XML lines which do not import properly. The user can then inspect the 
XML file and find the reason for the error, and/or alert the developer of EPR system to fix the errors.

Loading loom layout from the fabric no longer changes the default path for fabrics, as customer prefers it that way.

On weft blanket, add support for Ctrl+C, Ctrl+V, so that user can more easily copy thing which do not fit on the 
screen. Ctrl+C stays selected regardless of the current selection, Ctrl+V pastes to current selection.

If selvedge is just two points wide, and we have regulator and fil coupe, put that weft completely up, so it does not 
work in leno weave (splitz) in the edge. Otherwise they need to correct this manually, or fix the card by hand.

When using cut and paste of warp or weft pattern, convert ending new lines in spaces, so that vertical warp patterns 
from excel can be pasted directly in the program. 

Added shortcut functions Ctrl+2,3,4,5,6,7,8,9,0 and Alt+2,3,4,5,6,7,8,9,0 which makes satin and twill weave as 
multiplication of existing weave, also to main weave editor. Previously, this function was only available in jacquard 
conversion. Function does not work on selection.

Added shortcut functions Ctrl+2,3,4,5,6,7,8,9,0 and Alt+2,3,4,5,6,7,8,9,0 which makes satin and twill weave as 
multiplication of existing weave, also to double weave editor. Previously, this function was only available in jacquard 
conversion. Function does not work if there is not enough space for the expanded weave.

In warp density HTML report, added information that reported density is finished, as some users were confused about 
that.

Changed label in file selection box from "File search pattern" to "Filter", which is nowadays understandable.

In weave editor, in Dobby, Drafting, reordered functions "Warp" and "Random" and put them in separate "From" menu.

In weave editor, in Dobby, Drafting, added function From > Weave, which takes the drafting from weave, by using first
vertical black point as indication of drafting.

During export of XML fabric with checking of yarns enabled, added checking for existence of yarn codes and yarn color 
codes also in variants.

Writing of WIF files was limited to dobby sizes up to 100 shafts. Now we have raised that limit to weave sizes of 
8192x8192, or the maximum size the ArahWeave PE supports. In this way, you can use WIF files to save jacquard 
fabrics as well. The file format is very inefficient, so files are quite big (several megabytes for large weaves) but it is 
the only way to transfer weft color information to some handloom jacquards (Digital weaving Norway TC-1/TC-2).

Added function "Card to editor" which permits you to copy the jacquard card image directly to weave editor, without 
having to save the card to disk and loading back in as card image. This function can be useful for some special editing 
purposes. We use it internally for splitting the card image in several smaller files.

Printing or saving of multi-fabric or variants to 8 bit color formats or images is now also supported. In this way, we can
save the simulations directly to 8-bit PNG or GIF, or print to Postscript printers.

Reduced some small rounding errors when printing one repeat simulation; previously it would sometimes add an extra 
thread or two, depending on dpi setting and repeat size. This would not be visible on normal designs in repeat, but on 
one piece designs, it would seem like an error to the final customer.
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Added automatic dividing the card image in several files, if you are using Staubli JC5. You can set the parameter 
"Divide file (wefts)" in save cards for production, and program will make file_01.jc5 file_02.jc5 file_03.jc5 ... until the 
whole design is saved. The minimum number of wefts is 250, if it is smaller, the value will be ignored and program will 
save only one file. At the moment, the primary use of this function is to enable punching of cards on Staubli 19.33 
punch card machine, which only allows punching up to 350 picks in one file.

In save yarn, added button to create directory.

Added configuration option for command which provides JPEG to PDF conversion. This command is then used in PDF 
printing to convert the JPEG image into PDF.

If first variant has a name, report variants in XML, even if we have only one variant.

Added option to save XML of the fabric every time fabric is changed and recalculated.

This option should be used only with customers who do not have automatic connection with ERP to import XML files, 
otherwise it will create too much traffic

It should be used for customers who use XSLT stylesheets to display customized HTML files generated based on XML.

In weave editor function Tools > Move weave..., added arrows button to specify direction of moving (left, right, up 
down) and to allow the user the selection of direction of moving.

Added saving of weave grid size for both X and Y direction. Previously, only grid X was saved, and grid Y was 
sometimes initialized to wrong default.

Added loading of Act .WJL dobby cards, including extraction of dobby cards. The reading does not work 100% for all 
cases, since we do not have documentation. Only dobby card and weft change are extracted automatically, regulator 
and variable weft density are not, since their position is not clear.

Added saving of fabric property "Pieces", which tells how many pieces are we weaving in parallel. This is useful for 
customers, who are weaving several scarves or napkins in parallel.

If you changed the system in extra weft or fil coupe conversion, and did not press enter or use arrows, but instead 
click on some other field, program did not immediately increase or decrease number of weave blocks, and this was 
confusing to users. Now the number of weave blocks is refreshed as soon as you leave that numeric field.

Added support for calculation of one piece price according to number of pieces which are woven in parallel.

On save cards for production, in function reverse fabric, re-enabled horizontal mirroring of the weave. Previous 
optimization was only inverting the weave, which is not OK if you have fabrics with text. But you run the risk if you 
have warp pattern, and by reversing the weave, the warp pattern should also be moved.

In card preview with vertical mirroring and weft yarn color preview, the weft color is now properly mirrored.

In card preview with vertical mirroring and weft yarn color preview, display fringe weft color as light grey, instead for 
some random weft color.

Added fabric property "piece dyed". Default is no piece dyed. Property is also exported in XML and can be imported 
with XML fabric import.

In yarn editor, added button to choose fiber sort order in drop down menu. By default, fibers are sorted by name, but 
you can sort them by code. Since we now have fiber codes directly in the drop down menu, the help list with sorted 
fibers is no longer necessary and has been removed.

In saving Staubli Delta 100/110/200, separated Signal field from Notes field (previously, it was only renamed from 
Signal field from Vega).

Added preliminary support for dobby format Action .WJL, a Chinese dobby loom controller. We are still missing some 
info about the checksum, and the relative position of the dobby and weft control is not yet clear, since sample files 
have it at different positions.

Changed default of "Elongate on indivisible selvedge" so that it is off by default. Many customers have complained 
because it made long card files, but they did not know why.

In numeric text fields, you can use wheel mouse to change the numbers up or down. If you press Ctrl with wheel 
mouse, the change of value goes by 10 instead of 1.

In numeric fields with arrows, you can use wheel mouse to change the numbers up or down. If you press Ctrl with 
wheel mouse, the change of value goes by 10 instead of 1.

Allow even longer custom yarns, up to 4 million pixels, that is about 100 meters of yarn for Nec 30.
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Allow even longer multi-color lengths of yarns (from 30 to 50), but only make stripes longer, do not make yarn even 
longer.

In making woven header and footer, added button for automatic copying of fabric name to the text field.

Added function to save yarns with all colors in HTML table. In this way, you can view together all the yarns defined in 
imported XML, but with nice display of colors (if you defined them), and grouped together. File is saved as Yarns.html 
in the default HTML directory.

If you are re-saving all files from browser (using Alt-S), program now automatically enables density from technical 
data. This is necessary since some customers were importing fabrics using XML, while density from technical data was 
disabled, and all fabrics were shown with wrong density. Using this function, we can correct the fabrics.

Increased maximum level of weave magnification or division in jacquard conversion from 30 to 60.

In automatic weft blanket names, we now support $M and $m, as well as $N and $n. The variants with small letters do
not increment the global count number, so that you can repeat the equal fabric title several times, if you need.

In automatic weft blanket names, we now support $M $N $m $n followed by *. The number of asterisks must match 
the length of the number that we want to insert. Asterisk will make the same number as the previous one, with 
increment rule dictated by interpretation of $M $N $m $n.

Since variants are used more and more, added number of variants in the fabric icon. We had to change fabric icon 
format for this, so all fabric icons must be re-created. Number of variants is now shown on fabric icon tooltip, and you 
can also sort fabrics by number of variants. Detail view also shows number of variants, and you can sort by that key. 
Filter also allows using number of variants as numeric criteria for selecting desired fabrics.

Fixed sorting by number of colors for true color, transparent and vector images.

Added loading of variants from fabric file. You can click on the browse button on top right of the variant window, and 
load variants from the fabric. At the moment, only additional variants (not basic fabric) are loaded, since basic fabric is
not a variant. We could change this, if we started saving the first variant besides the extra ones. Maybe we will do it, if
customers will request it. Program does not check if number of warp or weft colors is the same, it blindly loads the 
variants. It is wrong on one level, but it gives you more flexibility, since you can still load the variants, even if you 
have bigger or smaller number of yarns. We could add a warning on this, but user anyway sees it and knows what he/
she is doing.

In fabric with warp creel sections defined, added saving of status of vertical display of creels, and status of numeric 
display of cone entry on creel.

The function remap weave now allows longer remap strings, so it has been converted to multi line text entry field with 
a scrollbar. So it is able to handle same lengths as the weave shuffle.

Added regulator to position 24 on Action .WJL dobby format.

In variants window, you now have a button "copy yarn" in the top right, which copies the yarn properties of selected 
yarn to all yarns. If the whole variant is selected, then  all yarns of the current variant are copies to all variants. The 
colors are kept intact. In this way, you can quickly change all yarn properties for all variants. For example, you want to
change yarn luster, to make it more shiny, or you want to transform one yarn in metallic. You change it, press the 
"copy yarn" button, and you have it in all the variants.

In warper window, the position of scrollbar is now kept, as you change the warp section length and the warping is 
recalculated. You can use this to visually position the warp on creels and see the exact starting position, as you change
the warping parameters. Before this change, scrollbar jumped to top position every time, so you could not see the 
change, if it was at the end of the warping plan.

Big improvement in warping development, by request of Beta Weaving from Thailand. Now we give option to display 
creel numbers, besides yarn letters. We can also display yarn consecutive number. If you use wheel mouse in section 
length or offset, the layout gets updated automatically. You can center the warping on two creels. You have the button 
to automatically set the offset to the center, or you can enter the offset value by yourself. All those settings are also 
saved in fabric or warp file.

Added mirroring of warping as an option in warping planning.

In writing CCI dobby cards, elongate the weft pattern and variable weft density, so that it matches the length of the 
weave. Also added support for writing variable density of single density as threads per inch, not only as threads per 
cm.

In XML export/import section of setup, added an option to rewrite warp/weft pattern when exporting fabric as XML. 
This is needed because some ERP systems are not able to read warp/weft patterns without numbers, for example "ab" 
instead of "1a1b". Now we force the program to rewrite it with numbers. This might slightly change the warp/weft 
pattern, but the sequence will stay the same.
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Added second high quality view, which makes simulation by covering 5 wefts instead of just 3. It can still hang in some
cases, so for this reason we keep the normal high quality as well. Also, in some cases the background yarn still shines 
through too much. But in many cases it is much better.

Added translations for 3d object types and fabric categories.

Increased the maximum number of warpers from 4 to 5.

In variants, added possibility to insert variant with [Ins] key, not just delete with [Del] key. If you insert variant, the 
current variant is duplicated, and other variants are moved over.

In variants, added a function to find duplicate variants. It is useful for customers who make hundreds of variants and 
want to make sure that they do not make duplicate variants.

Update the contents of variant print settings window as you load new fabric.

On importing yarns by XML, switch internally to integer view, so any calls to simulation will not slow the program 
down, and then switch back to default fabric view.

In loading variants from a different fabric, we now also load first fabric variant (base fabric yarns and colors), not only 
the variants. This is necessary, because in variants, secondary variants refer to the previous variants, and if first 
variant is different, then some variants in the middle can come with wrong colors as well. This function can also be 
used for loading all the yarns from one fabric, so you set them for another fabric, even if the fabric does not have any 
variants.

Added possibility to set custom color for titles. By default, text color in title printouts is black, but now you can set it to
a different color in Help > Save setup in Colors tab.

In fabric browser, if you enable filtering by variants, program now displays the total number of variants in the directory
in window title.

Added buttons + and - in variants, so that you can add or remove variants even if you do not know that buttons Ins 
and Del already do this.

If yarn is selected within variant, then buttons are disabled. You need to select the whole variant, by clicking on the 
title in order for these buttons to work.

On exporting fabric as XML, you can now enable  "Yarn color exists" in "Data export" of "Save setup". If this option is 
enabled, then program checks if the yarns in the fabric its variants actually exists in selected colors. If not, program 
gives a warning, displays information about the wrong yarns, and does not save the XML of the fabric. This function 
only works, if ArahneYarnToColor.xml is present in the default XML directory, since it uses this data to check yarn 
correctness. If the file is not present, program warns the user.

During export of XML, apply first variant, because maybe user has just loaded the yarns into variants, but did not 
apply them, so exported first variant could be wrong.

On saving XML, report dobby information if weave can be made on dobby loom, and jacquard information, if jacquard 
format is selected.

Allow longer lines in description of the loom; previously, maximum length was 150 characters, now it is 500. In this 
way we allow longer paths in destination where we do not send files by ftp, but store them in some location.

Moved settings parameter "First palette color one" from weaving tab to appearance tab.

In save setup, weaving tab, you now have more options for quality control while saving the jacquard cards. Besides 
fixing long floats in warp and in weft while saving jacquard cards, you can now also set the limit for warning on warp 
lifting % and for warp consumption variation. Both values can be controlled in the properties window of weave editor. 
Now, the program can issue a warning if one of those thresholds is exceeded, while saving jacquard cards. This can be
useful as a means of quality control, which prevents problems in production. If you don't want any warning, just leave 
both at default values of 100.

During import of fabrics by XML, program loaded colors into fabric based on its code, using the color library, but it did 
not load the yarn. Yarns were left at the basic settings from XML, while more advances settings like hairiness, metallic,
mouline, etc. were not set at all. In this first iteration, only the yarns of the first variation are loaded, This could be 
good enough, if in optional variants, only the yarn colors are changing. If yarns in variants are also changing, we need 
to add it too, but with check for yarn equality, so we do not load thousands of yarns for a single fabric, we should copy
them, if we already have them.

Added <BackgroundColor> tag to ArahneFabricImportOrder.dtd file, also added loading of background color. 
Previously, the XML imported fabrics "inherited" the background color from the default files.
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Changed function "Load dobby weave" from file selection box interface to browse interface, so that we can filter the 
weaves by number of shafts.

In remap weave, added a function to remap dobby card as well. In this way, we can change order of shafts. Currently 
the program keeps drafting and modifies the weave. We could also make a function to keep weave and modify 
drafting.

Added support for XML processing of arahDrape projects in server mode.
In default XML directory, you need to create directory "drapeOrder" and in that directory you create direcotries "in" 
and "out", just like for other XML server commands.
There you need to place drape request XML file, here is a simple example
<?xml version="1.0" encoding="utf-8" standalone="yes"?>
<!DOCTYPE ArahneDrapeOrder SYSTEM "ArahneDrapeOrder.dtd">
<ArahneDrapeOrder>

<OutputFile>/tmp/mapped.jpg</OutputFile>
<TextureFile TextureNumber="1">/home/capdam/data/img/textures/6234-T.jpg</TextureFile>
<DrapeProjectFile>/home/server/data/drape/pure country/Couch-Blanket.drape</DrapeProjectFile>

</ArahneDrapeOrder>
The file needs to be created according to this .dtd file.
<?xml version="1.0" encoding="UTF-8"?>
<!ELEMENT ArahneDrapeOrder (OutputFile, TextureFile+, HideModel?, Divide?, FilterPNG?, CompressPNG?, 
ModelImage?, TransparencyColor?, DrapeProjectFile)>

<!ELEMENT OutputFile, (#PCDATA)>
<!ELEMENT TextureFile (#PCDATA)>
<!ATTLIST TextureFile TextureNumber CDATA #REQUIRED>
<!ELEMENT HideModel (#PCDATA)>
<!ELEMENT Divide (#PCDATA)>
<!ELEMENT FilterPNG (#PCDATA)>
<!ELEMENT CompressPNG (#PCDATA)>
<!ELEMENT ModelImage (#PCDATA)>
<!ELEMENT TransparencyColor (#PCDATA)>
<!ELEMENT DrapeProjectFile (#PCDATA)>

Fixes in importing ArahneFabricImportOrder XML, so that it better matches files created by exporting XML fabric for 
import.

In ArahneFabricImportOrder XML, added support for saving images in 8 bit colormap for PNG and TIFF formats. We 
use PrintColormap tag after PrintDPI to select colormap output.

Added saving of warp pattern in Staubli Delta 110/200 format. It is written in a separate file named SCHA0NNN.dat 
where NNN is number from 000 to 999.

In XML fabric import, fixed support of fabrics with regulator passed in XML. Previously, regulator was always taken 
from the jacquard card, and the passed regulator was lost. If you want to use the regulator from the card, pass empty 
regulator information in the XML.

Added a parameter to configuration file to control the delay in processing of XML files in server mode.

The default was 3 seconds. You must enter the value in milliseconds, so you can make the delay as small as 0,10 
seconds, if you enter 100 milliseconds. Note that created images should be small in order for this to work. Please test 
well before lowering the values too much, as good functioning will also depend on your CPU, RAM and disk speed.

Greatly improved the speed of fabric import with XML server. Previously, program was doing refresh of the fabric view 
during import process and card extraction, while now it no longer does it.

Removed the settings to post 3D fabric data to internet by ftp. The function was never fully implemented or used. Also
removed the option to modify the webgl file according to the fabric filename.

If you change number of protected variants, fabric becomes changed.

If you are using both warp and weft yarn variants, we now display a separator line between warp and weft yarns.

In variants display, legend of yarn (a, b, c) on the left side is now always visible, even if we scroll to the right and the 
beginning is no longer visible.

Optimized the drawing of variants, so that only variants which are visible are drawn, if we have scrollbars. On slower 
computers and fabrics with large number of variants, this should make a difference in rendering speed.

Reduced flicker in yarn letter indication area when scrolling or selecting a yarn in variants window with large number of
variants.
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Optimized drawing of variants, so variants are only drawn once for each mouse click to select a variant. Previously, 
program did two refreshes.

If you are using variable selvedges using the selvedge pattern, program now continues the single weave from the 
previous pattern, so that the weave always continues nicely. Previously, if you had selvedge pattern 10(1a1b), and a 
was a plain weave, you would get just one part of the weave, since it would always hit the odd points.

In variants window, added a button to reload yarns. You can press this button if the yarns have changed, and you want
to update all yarns to the latest saved yarns status. If you have XML import files with yarn availability, the yarn prices 
also gets updated.

Enabled divisibility calculation in "Conversion > Set jacquard to divisible", also for color shading. Previously, it was only
working for colormap images.

Changed behavior of Enter button in weave browser, when we are loading jacquard weaves. The Enter button also 
blinks the selected color in jacquard conversion, and since weave browser is often open during setup of jacquard 
conversion, and window pops up automatically so that it does not stay back, we have made it not into blink operation, 
instead of the default loading of weave. For loading the weave, you need to double click on the weave in the browse, 
or select the weave and click OK.

Changed toggle button "Elongate on indivisible selvedge" in "Save cards for production" from toggle button to numeric 
filed. If the value is 0, final weave is not prolonged. If the value is 1, it is prolonged for divisibility, up to maximum 
length of allowed weave size. For other values, for example 40000, program will make weave up to 40000 picks, and 
select the main weave multiple which has the smallest remainder after dividing with selvedge weave, even if it is 
indivisible. Because sometimes it is just not divisible, and we prefer that the program picks best size, even if it is 
indivisible. At the same time, we do not want all designs to be maximum weave size, so we limit the final weave size 
to a reasonable value, which user can enter.

In fabric browser, added saving of loom weft density, reed number and reed width. Program now displays this 
additional information in fabric popup. It is also possible to sort the fabrics by those new fields, both in icon view as in 
detail view. It is also possible to filter the fabrics by these parameters.

In .csv export of the fabrics, added loom weft density, reed number and reed width.

In reading the fabric, filter out the <> characters in yarn fiber composition, since those characters then confuse HTML.
We had a bug where those characters were saved in file for some time, so now we remove them in reading, so old files
are OK.

In save cards for production, added "custom weft change 4", which allows you to enter an additional weft change 
binary pattern. In this way, you can have two binary weft changes for the same weft, which are different. Some 
customers need it in order to have left and right weft change, which is mirrored, and then they punch the cards, and 
cards can be reversed, in order to weave bottom up, if needed.

On most text filed entry with names and codes, which later appear in HTML printouts, we now block characters <, >, &
since they are not allowed in HTML and break the correct rendering of the web page in browser.

Only display number of variants in tooltip if we have variants, do not display 0.

Increased maximum number of entries in loom layout from 40 to 50.

In decomposed warp/weft pattern layout, we now allow warp/weft patterns like in decomposed weave editor.

So you can use parenthesis and only letters, if you wish. Only up to 10 segments are supported, but this should be 
enough for most multi-layer fabrics with patterns.

Change default ArahPaint program version to open from ArahWeave jacquard conversion form version 4 to 6.

In yarn editor, gray out the display of twists per meter and yarn contraction, if twists are set to 0. 

In color editor, Change menu, added function "Make color atlas from variants", which copies all the colors from yarns 
in variants and creates a new color atlas. In doing so, it removes any duplicates. This allows the used to quickly make 
custom color atlases. Previously, we advised the users to copy the desired colors in yarns, then create new color atlas, 
and copy yarn colors to the atlas. Now you can simply make variants, increase number of variants according to the 
number of needed colors. Then copy the desired colors from color atlas to variants.

You may also switch to a different color atlas, if you wish to take colors from several different atlases. Once you are 
done, simply call Change > Make color atlas from variants, in Color editor, and you have the new color atlas. If you 
wish, you can also rename color codes or change colors, by making them lighter or darker. Finally simply save the 
color atlas with a new name; do not forget .col suffix.

In color atlas properties, added a button to clear values (custom suffix, atlas name, copyright warning, …) This can 
help you to quickly get rid of PANTONE copyright settings, if you have converted color variants to color atlas.
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In drawing drafting by mouse, if you keep the mouse pressed and draw, it will make repeated straight drafting in the 
enclosed rectangle. We made a modification, so that if you press Ctrl while performing this operation, the drafting will 
be zig-zag (pointed drafting).

If you had dobby or some other non jacquard format as default jacquard format, and you switched to jacquard format,
then all the 50 fields for loom layout were visible, instead of only the one matching the layout.

Finished support for Delta 100/110/200 drawing in machine. The extra parameters of this machine are also saved in 
loom layout. Selvedges are supported.

If you made straight drafting on a large weave which could fit on dobby, but you wanted to disable shafts, program 
beeped and did not clear drafting. Now it makes straight drafting internally, and dobby information is hidden.

Modified layout of the window "Save cards for production", so that window resizes better when new buttons and fields 
are mapped or hidden. In particular, the toggle button "One repeat" enabled display of buttons and fields which could 
not be made fully visible, if the default loom layout did not have them visible. Now, they properly enlarge or reduce 
the window, if they are needed or not.

In yarn import from XML, relaxed control of yarn twist contraction, before we allowed yarn twist +-30%, now we allow 
twist contraction of +-80% 

In XML fabric export, added optional information for support of two warps. In header section, after 
<TotalWarpThreads> added <TotalWarpThreads1> and <TotalWarpThreads2>. In warp section in WarpUsage for each 
yarn, after <SelvedgeThreads> added <WarpThreads1> and <WarpThreads2>.

In fil coupe jacquard conversion, we have set the limit of fil coupe simulation to length of fil coupe - 2 x fil coupe 
protection. Now we just set it to length of fil coupe – 2. This value is also used in long float correction, as floats longer 
than fil coupe are not corrected. Some customers have complained that some floats were remaining, so we have 
increased the value of fil coupe simulation.

In server mode in XML creation of multi-print images, reduced the level of feedback and make the image in one go, so 
it will be faster.

In server mode in XML creation of multi-print images, fixed rounding error in printing one repeat fabric simulations.

In reading of ArahneYarnToColor.xml, added support for yarn location. The updated .dtd file with location information is
this:
<?xml version="1.0" encoding="UTF-8"?>

<!ELEMENT ArahneYarnToColor (Yarn*)>
<!ELEMENT Yarn (YCode, YColorCode, YStockKG, YPriceKG, Season*, Location*)>

<!ELEMENT YCode (#PCDATA)>
<!ELEMENT YColorCode (#PCDATA)>
<!ELEMENT YStockKG (#PCDATA)>
<!ELEMENT YPriceKG (#PCDATA)>
<!ELEMENT Season (#PCDATA)>

<!ELEMENT Location (#PCDATA)>
<!ATTLIST Location YStockKG CDATA #REQUIRED>
<!ATTLIST Location Packaging CDATA #REQUIRED>
<!ATTLIST Location Shelf CDATA #REQUIRED>
<!ATTLIST Location Bath CDATA #REQUIRED>
<!ATTLIST Location Lot CDATA #REQUIRED>
<!ATTLIST Location BarCode CDATA #REQUIRED>

Each yarn can have up to 5 locations.

We now have a button in yarn browser, which displays yarn location information, if stock is higher than 0.

New filter in weave browser: show only weaves which have same drafting as the current weave. So we can load them, 
to see if we like the result, and we can quickly weave a new weave on existing loom setup.

In variants, added buttons to load yarns with file selection box and with yarn browser. Many customers do not have 
XML files for yarn definitions, so they prefer loading yarns from file selection box.

If we introduce new icons with update, and we use icon zoom, then the new icons will not be visible, since it is not 
scaled until you change the zoom factor. Now, the program tries to scale the icons which it does not find. As a 
consequence, on the first run some icons are still missing, but if you run the program again, the icons are made and 
program works.

Changed the behavior of "equal drafting" toggle button in load cards browser, so that it only checks equal number of 
shafts instead of drafting, which is not used loading dobby cards. It serves as a shortcut for filter Shafts = NN where 
NN is number of hafts in the current weave. The advantage is that you get filtering by number of shafts with one 
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mouse click, and you do to need to set actual number of shafts. Using this option with an interesting drafting, you will 
be able to create many more interesting weaves.

In HTML fabric printout window, replaced "new page" text buttons with icons.

In HTML fabric printout window, added buttons "Stock" for warp and for weft. This allows you to print the yarn stock 
information besides the used yarns. It is based on the XML import data. If ArahneYarnToColor.xml also contains yarn 
location, that is reported, too. Up to 5 yarn locations are reported. Only yarns with valid yarn code and yarn color code
will report the data in this way.

Replaced weave browse size menu with fixed values, 30, 40, 50, 60, with a numeric field which allows values between 
30 and 85. In this way you can now interactively scale browse window display area for single weave, and view weaves 
at any size you like. It is very good for quality control, since if you view weaves at very small size but repeated several
times, you can see the errors very quickly.

Greatly relaxed weave grid and display area limitations; grid can now go from 1 to 9, and display size form 20 to 400. 
Maximum display size in pixels for single weave is 512, so in case the grid x display size gets bigger that 512, one of 
the display parameters is reduced. You can use wheel mouse on grid and display size numeric fields, and get 
immediate refresh of weave display, so you can quickly set desired view parameters.

Changed the settings of weave display in jacquard conversion from fixed sizes 60x40, 80x60, 120x80, 180x120, 
240x160 to free size value form 20 to 300. In this way, the user can set the display better according to his/her 
eyesight, screen size and design necessities. The default value is also saved in .arahne setup.

Changed browse feedback with counter of number of files read, so that on Linux, it refreshes the number every 0.2 
seconds, while on Mac it does it every  half second. Mac XQuartz is slow and we try to make feedback which does not 
slow down the operations.

Added Ctrl+wheel mouse to weave browser to increase or decrease grid size.

Added keyboard shortcuts + and - to weave browser to increase or decrease number of weave points displayed.

Changed behavior of expert function weave database conversion, so that it by default also reduces wave size to 
minimum. The parameters in weave database conversion are:
1 – invert
2 - mirror x
4 - mirror y
8 - mirror xy
16 - reduce repeat to minimum
If needed, you can combine several options.
To change the options, find in the "weave" source file convertWeaveDatabaseCB(16) and set the parameter to the 
value you need. 

Added weave editor function to halve the weave in warp or in weft direction.
It serves to quickly cut in half a larger weave.
Atl+> Halve weave size warp
Alt+< Halve weave size weft

If you changed weave size with wheel mouse or enter from numeric filed in dimensions dialog, undo did not work.

In dobby weave shafts optimization, we try to group similar shafts together, if we have system or custom double editor
layout. Since in many case the result is not the preferred straight drafting, we now apply this function only if double 
weave editor is visible. If it is not visible, we probably do not care about special shaft grouping, and we prefer more 
logical sequential drafting.

In operations which need to draw many filled rectangles, united the buffer allocation and drawing operations for all 
functions. The buffer is now allocated to the maximum size allowed by the X server, so the drawing can be fastest.

In weave editor, added a function View>Border, which draws one point over the edge in repeat over the border. In this 
way, you can more easily see the errors in repeat. The setting is also saved in setup.

In saving Staubli Delta 110 weft pattern, limit the number of characters in yarn description to 16, as this is the limit in 
file format.

If you had wrong (non-existing) directory in default selvedge weave definition, program beeped as you clicked on the 
weave area to change it. Now the unnecessary weave directory setting to file selection box has been removed, as we 
now use weave browser. Same removal was also done for header/footer weaves, and for weft blanket separator/title 
weaves.

If we are generating jacquard files by XML using ArahneWeaveOrder, we now always disable elongate indivisible 
selvedge, since it is not desired in this case, and users can easily mess up the used loom layout.
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In image browser, display also number of directories in the window title.

In pricing calculation, added a column with %, which shows the relative percentage of each parameter in final price, so
that the user knows which parameter is more important, when they try to lower the price.

Further fixes in Staubli Delta 100/110/200; now writing patterns with selvedges is properly supported, empty dents 
work, weave which is indivisible between denting and weave size is properly extended, card name is written in warp 
pattern instead of fabric name.

Some customers put very big selvedges in loom layout by mistake, and then use saving of loom layout in fabric file, 
and program then does not load such fabric files, since maximum selvedge size is exceeded. We have now raised the 
limit of maximum selvedge weave size from 3000 to 5000. We also enforce limiting selvedge weave size to 5000, so 
users can no longer make files which can no longer be read.

If you had wrinkle image setting in the fabric, and saved the fabric, settings were taken into account on next loading, 
simulation would be correct. But interface settings stayed at default or incorrect values, they were not updated.

When loading just warp from the fabric, read also waste warp (both fixed and as %), since they have part of the warp 
parameters.

In fabric consumption calculations, "waste warp" and "waste weft" parameters were only expressed as %. In many 
cases we prefer to have it as length (meters for warp, cm for weft), since loss in warp preparation or weaving is fixed 
and determined by the machine (particular warper or false selvedges on the loom).

So now you have both ways of setting the waste. Default for old files is 0. All these parameters are also exported as 
XML, printed in HTML, or even imported as XML.

The length can also be inserted in metric and imperial units.
<WasteWarpFixed lengthUnit="m">6<WasteWarpFixed>
<WasteWeftFixed lengthUnit="cm">3<WasteWeftFixed>

In jacquard conversion, you can now have several weaves, each with its own custom layout, and the layout is now 
kept in each single weave, as well as saved in the fabric file. So the next time you open a weave from jacquard 
conversion, it will come up with layout with which it was made, not with generic layout which is the same for all the 
weave in the fabric.

In reading floating point parameters, if the parameter string is empty, read it as minimum value, not as medium 
between minimum and maximum value. This helps set parameters to 0 or unused, if we do not use some parameters.

Added reading of ArahneBlockWarehouse.xml, which is a simple list of yarn stock warehouse codes, which we do not 
want to be reported in the yarn warehouse list. The customer who ordered this feature (Sordevolo) also tracks yarn 
position within the factory, so they know if yarn is in warping, weaving, dyeing, twisting… and they do not want those 
to be reported as stock. So using this list, we can disable it. This is he contents of the ArahneBlockWarehouse.dtd 
which defines he XML file.
<?xml version="1.0" encoding="UTF-8"?>
<!ELEMENT ArahneBlockWarehouse (Value*)>
<!ELEMENT Value (#PCDATA)>

Some customers use yarn count in yarn code, so they do not want to print yarn count in HTML printout, in order to 
save space. So we have introduced the option to disable printing of yarn count in warp and in weft HTML printout.

Added dobby card extraction for Nuovo Pignone .ARM, so that dobby card, regulator and weft change are extracted 
automatically if you load the card from "Weave > Load card".

Changed the logic of idle weave on skipped hooks, so that it continues along the skipped hooks. This avoids some 
regular patterns, if you use skipped hooks in a regular pattern, and weave to be used for skipped area has also same 
kind of repeat. It is actually not important, since those hooks are not weaving anyway, but some customers could be 
confused into thinking that the function is not working correctly.

In weave editor, added a function to load weave in superimpose mode. It works from weave browser. If you don't have
a selection, the program enlarges the weave until original and superimpose weave are compatible in size, and then 
adds the black points of superimpose weave. You can also use this function on selection, in that case, the size will not 
be increased. Protected yarns are also working correctly with this function. Drafting is deleted, as it is not possible to 
keep coordinated dobby weave after applying this function.

Added function "Select all card" besides "Select all" in weave editor.

Added <!DOCTYPE html> at the beginning of all HTML files, so that it conforms with HTML5 requirements.

Yarn browser now also reports the number of colors in the yarn.
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In weave editor, load superimpose, changed the function into menu, where you have buttons for add, remove and 
invert. Previously, program only worked in superimpose add mode, as this was usually presented in weaving books. 
But since we work on computer, it makes sense also to use the weave to remove points, or to invert points.

Added warp browsing in a graphical way. Warp browsing displays in the repeat label the following information: number
of warp threads in fabric width, warp repeat, and number of threads used. So display of label is different from normal 
fabric browser.

On some patterns with empty dents, if fabric ends with empty dent, and we reverse fabric, then fabric starts with 
empty dent. But since that is illegal in ArahWeave, then denting is no longer reversed, once you reverse the fabric 
back. So now we do not reverse denting in case denting repeat ends with empty dent.

In save setup, XML import section, added toggle button to allow negative quantities during import. Many customers 
have negative values in the yarn stock due to various errors, but they still want to see and use those yarns, as yarn 
color codes are valid and may be reordered, if stock is low.

After loading warp, keep the previously selected yarn.

After loading warp, disable protection on variants.

In loading warp, also load reed width, raw width, finished width, denting, reed number.

Corrected xml header in fiber definition files.

If maximum image size is increased from 65530 to 262140, then calculation of allowable print area failed due to 
integer overflow in calculations. Now program calculates limits correctly in this case as well.

In entering fields which require DOS filename, automatically convert characters / and \ into _.

In extracting weft change from card, we now remove external parenthesis, if it simply repeats the pattern. So a 
pattern of "500(1a1b1c)" will be written simply as "1a1b1c", as it will result in the same fabric. Shorter weft pattern 
will help us if we will subsequently try to modify the design, since we will not be bothered with indivisibility.

Warp browser uses independent history file which is independent from fabric history file, so we now also set history 
directory list in browser according to this.

In weave editor, added Edit > Invert mode. If you enable invert mode, mouse drawing works differently. In normal 
mode, left mouse button draws sets point (black), right mouse button cleans point (draws white). In invert mode, it 
will change black point to white, and white to black. This is useful for users of graphical tablet with pen, where drawing
white points with right mouse button is difficult, since pressing a button on pen (right mouse button) can interfere with
normal drawing (left mouse button). In this way pen or touch device users can draw a weave just by changing the 
existing points, without the need to choose black or white draw color (left and right mouse button). When using invert 
mode, you must be careful to click only once, or one drawing operation will be annulled with the next one. This 
function works, on weave, dobby card and on regulator. It does not work in any other part of the program. The choice 
of this behavior is also saved in .arahne configuration file.

Improved invert function, so that it filters out very short clicks on same point in combination with invert mode. 
Graphical tablets send multiple consecutive clicks on drawing, and invert mode can not operate correctly on first click, 
as a consequence. So we have to filter out fast consecutive clicks.

Custom warp or weft layout was no longer written with weave, if layout was comprised just of one character. Bug after 
rewrite of fabric saving functions.

In toolbar of image browser, we now have a function with compress icon. This function will correct some bad PNG files,
which were saved with a previous incompatible version. It will also optimize the PNG file and make it smaller. JPEG 
files will also be made smaller. It has no effect on other files. Shortcut for this function is period ("."), since it will make
files smaller.

Changed file size display from left justified to right justified, since on large files, the whole number would not fit, and 
you could not see the significant number on the left.

Fabric icon is now read from the setting of browse icon size, it can be between 100 and 250 pixels. You need to restart 
the program after change in browse icons size. All icons need to be recalculated after change of icon size, so program 
might be initially slower, until all the icons are recalculated. 

Added background color white and text color black to HTML files that we generate. Firefox on SUSE 15.1 defaults text 
background to some level of gray, so logos with white transparent background look ugly, and printouts which include 
background color use extra ink.

Increased number of entries in decomposed warp/weft editor from 9 to 20.
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If you are saving Vamatex .PID and .PIW together, program adds W automatically to the .PIW file, since the loom can 
not load two files with same filename (even if extension is different).

Changed "Clear drafting on copy" into "Lock drafting". Many functions need to be modified so that it will really work. 
Up to now, the following functions have been adapted:
- drawing of drafting with mouse
- loading of drafting
- clearing or drafting with shortcut
- optimization of drafting with shortcut
- clearing of the whole weave
- duplicate weave x
- halve weave x
- extend weave
- resize weave
- resizing weave on warp with mouse on gray area below main weave
- delete warp
- remap weave in warp

If you enable blanket view all, but then go in variants and click on variant, default view is automatically enabled again.

If you are in blanket view, but have variants and print variants, blanket view is automatically disabled in variants 
printout.

In blankets, added function to convert blankets to variants, with automatic variant name according to blanket position.
In this way you can print blankets with variants using number of warp sections as number of horizontal variants, and 
number of weft sections for number of vertical variants. In this way you get complete blanket with proper labels and 
yarn labels.

If you have blankets enabled, program now also reports complete warp and weft pattern of the blanket.

In HTML fabric consumption, if it is a blanket, report whole warp blanket consumption, not just the basic pattern 
repeat.

Default window size for blanket is also saved in configuration file.

In fabric XML export added saving of tags <GroundWefts> and <RegulatorWefts> in <WeftUsage>, in case that we 
have a fabric with regulator.

In fabric XML export added saving of tag <FilCoupePercentage> in <WarpUsage> and <WeftUsage>, in case that we 
have a fabric with warp or weft fil coupe.

Previously, in Help menu, we only had the function to separately set the default fabric. Now we have added the 
function to set default color palette and loom layout. In sub-menu to set directories, we can also set default for yarns, 
weaves, images, cards, HTML, XML.

Warp usage and lifting can now be also reported for each component of decomposed weave. Display will change 
automatically as you click on the weave segment, or draw the weave.

In save setup, in configuration of print title, added option to disable printout of program name and version.

Fixed drawing of text labels with XFT in Motif, so that it caches calls to XQueryColor, which causes round trip and is 
excessively slow on Mac with Xquartz. This fixes slow menu opening on motif, part of slowness in window resize, and 
all of slowness in list view.

Disabled tooltip animation, tooltips just appear. Animation is mostly useless, but it severely degrades the performance,
especially with new fix of Motif XFT label drawing on Mac.

Changed function xPutBuffer, so that XSync is optional parameter, and drawing functions can tile buffer drawing and do
just one XSync, if we have shared memory pixmaps. In that way refresh is a lot faster on Mac, especially on icon 
browsing of images. Fabric browsing is also much faster. On Linux with Nvidia, you need to enable shared memory 
pixmaps in xorg.conf in order to use the speedup.

Optimized calculation of weave for display in icons.

In browsers, changed drawing of weaves, images, fabrics, so that now drawing uses all the available buffer, both 
horizontally as vertically. Only when it comes to the end of the buffer it does XSync. This improved the speed of 
browsing even further.

In metallic yarns, only the metallic property in first yarn color was actually used, and then it was applied to the whole 
yarn. Now the program properly uses metallic property for each color separately. If yarn model is mouline, all the 
single yarn colors have common offset, so metallic effect is grouped in the yarn totality. On other yarn models, each 
color has its own metallic offset.
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If you are sorting colors by CLE L, a, b, C, H, it only worked on colors with CIE Lab values. Now it also works on colors 
with only RGB values, as we convert them to CIE Lab to make these functions possible. If screen colors are selected, 
calculation is based on screen colors, otherwise it is done on print colors.

In help menu, added a separate function for saving default window size. The functionality is the same as opening 
setup window and clicking OK without any modifications in other settings, just that it saves one mouse click, and it not
a hidden function.

If you had jacquard conversion with gray-scale shading, and you used inverted weave for shading (make it warp 
faced), the non-shading weaves in the jacquard conversion were inverted with respect to the desired weave.

On loading yarn from browser in variants, but with clicking on yarn, without selecting the color, yarn was loaded, but 
variants were not updated.

If you switched between screen and print colors, color choice bar on the right of the color palette was always 
displaying screen colors. Now it displays print colors, if print colors are selected.

Reworked drawing of color bar in color editor, so that it uses the common buffer, and we can skip XSync, so drawing is 
faster.

In save setup, appearance tab, the popup menu for font selection was covering the font preview. So we have 
rearranged the font setting window so that preview appears on the top and is always visible. 

After reversing the fabric, yarn offset now changes, so the reversed fabric does not have same yarn positions on 
multicolor or slub yarns. But if you reverse it again, position is reset to original one.

On reversing the fabric with wrinkle image, wrinkle image is now mirrored. Otherwise on simple fabrics, wrinkle effect 
stays the same after reversal, which is obviously wrong. After reversing back, you get the initial wrinkle image.

Changed tooltip on directories in browsers, so that it displays number of files or number of directories only if bigger 
than 0.

On the Apple version of the program, ArahWeave can now open ArahPaint5 or ArahPaint6 with the desired image from 
the image browser or from jacquard conversion, if the image located in the same directory from which it was initially 
loaded.

In fabric browser, we now display number of other files and directories besides number of fabrics. In this way, user can
know if some other files are also stored in same directory, as this is slowing down the browse and causes confusion.

Weave browser now also reports total number of weaves, other files and directories. In this way you can find out that 
some files are misplaced, and are slowing down the browsing.

Cursor position for text fields is now by default at the end. In this way you can always use [Backspace] before entering
new value, if you use the [Tab] to move between the fields.

On applying separating pattern in weft blanket, remove trailing spaces and zeros in the pattern. If pattern is just 0, 
program tried to interpret it, but then it complained the pattern was not valid. But inexperienced uses maybe inserted 
0 when they did not want any separating pattern.

Function "Guess color from %" in Tools menu of yarn editor, was only working for CIE Lab colors, not for colors defined
with RGB.

In export of fabric as XML, added tags <AverageColorCIE_Lab> and <AverageColorRGB> so that the software which 
can only show one color per yarn can show more correct color. And to help programmers who can not calculate it 
themselves.

Preliminary support for printout of ruler. Ruler is printed at the bottom of the fabric.

Bugs

If user was saving integer view fabric simulation (in order to make images with stripes), program was using rounding 
correction factors for simulation views, and could make the image one pixel bigger, which could result in garbage 
pattern (display of warp pattern in all weft pattern). Now the program correctly makes exactly same size image as the 
current integer view.

Selvedge shafts were not reported in XML for cases when selvedge shafts were from ground. We also do not have 
selvedge drafting code, we use selvedge weave name for drafting code.

If you loaded a new drafting, fabric was not modified, and it exited without warning.

If you used filename suffix, loom layouts in choose menu had .arl suffix, but it should be hidden for simplicity.
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Border between fabrics in multi fabric printout should be in background color, not in white. Previous version had white 
in vertical border, and background color in horizontal border.

If you enabled one repeat print, the pixel size preview in print dialog was not updated accordingly for image formats 
like JPEG or PNG.

Label for program version in the printout title was too far on the right, not aligned to the owner name.

In weft blankets, if you had skip to next enabled, it did it also on separation weaves, where it was not expected.

If you had sort order by date in image or fabric browser, and then used filter to search by name, program reset the 
sort order to sort by name, while still displaying sort by date.

In writing of Toyota JAT cards, program wrongly reported one shaft more than the actual number of shafts used. Same
type of error was also discovered in Panter format, so we corrected it as well, even if no customer complained about it.

Printing of face and back for fil coupe fabrics was wrong.

Variants could be deleted with [Del] key, even if variant was protected.

Variant selection was incorrectly reset on loading new fabric, so selection status on the first variant was lost.

Since high quality simulation 2 is not yet working well in all cases (sometimes it hangs), we only enable it in expert 
mode.

Numbers on display of warp lifting or warp consumption were not aligned correctly according to chosen font size.

With the new function to check existence of yarn in particular color in export to XML, program always checked it if yarn
checking in XML was enabled, even if checking 

In importing fabric using XML, if the XML file had set the <Name>, <Code>, <Design>, <Version> tag, program 
would crash on import.

Setting of default windows size for variants was not working correctly.

Removed thin vertical line display bug in some cases with large number of variants.

Fixed cost in price calculation was only used if price per meter was not 0.

In yarn editor, if you selected an unused yarn, switched it custom yarn type, and entered the draw editor, program did 
not calculate the shade colors for such a yarn. This was annoying, since you could not properly edit yarns which were 
not used.

In reporting reed width with imperial units (inches), program displayed wrong values in browser detail view, browser 
popup and CVS output list.

If you made a modification in warp or weft pattern and applied it, fabric did not become modified, so revert to saved 
remained disabled.

On very long and complex warping with numbers enabled, program would crash on display of warping HTML data.

Variant window no longer resized properly if window was resized from its default size.

If you loaded warp with higher number of used yarns in warp, then program would not copy the first warp yarn to all 
variants.

In multiple image conversion with JC4 loom layout, the minimum on number of repeats and on number of wefts was 1 
instead of 0.

Writing Schleicher cards with number of hooks not divisible by 448 crashed the program. Now it refuses to write such 
cards.

If you were using multiple image conversion with HTML display of result, program did not clear old image and fabric 
files from the /tmp directory.

In weft blanket, the function to automatically progress to next fabric did not work, if you were loading weaves from 
weave browser. It worked OK on fabrics.

Alt+r was no longer working in image browser to toggle repeat view on icons.

Parameter "pixel to thread" was not read correctly from fabric files.

In reading and writing of some XML files, there was a typo: "Saison" instead of "Season".
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In making Reply to XML request, the Reply text was written twice in XML name, so ERP programs which were reading 
replies stopped working.

Indication of active selection in weave editor was no longer working for selection with middle mouse button and for 
Shift + left mouse button.

In some cases, if you saved the fabric, and then changed zoom level, fabric would once again become modified, and 
program would prompt you to save it.

Icons for directory and PDF were not properly scaled according to browse icon size; they were scaled according to 
basic icon size.

In case of icon scaling, scissors-big.png was also scaled, but it was not necessary, and it also failed, because image is 
bilevel bitmap.

Color picker with multi color yarn and non first sub color selected always changed the first color.

Multico yarns did not have yarn twist shade simulation, if ply was set to 1. It was then confusing since user did not 
know why a yarn converted from mouline to multico had twist simulation, while the one converted from normal single 
yarn did not. Now shades are always added.

Display of color bar was drawing extra area, which was clipped by the window, so the extra drawing was invisible.

For printers which do not have variable dpi (real printers instead of file formats), it was not possible to set the dpi 
setting other than the frist one on the list.

In HTML report of blankets warp report did not use same unit for blanket as for the whole fabric.

If you had square brackets enabled, program would convert drafting in pattern with square parenthesis, which would 
not be accepted in the text field.

So the numeric drafting would stay empty, and you could not use it properly.

Selecting a yarn, while color editor was open, would damage expose of atlas color bar.

Fixed a crash in changing the language on Mac OS X 64 bits.

Find closest colors did not work, if search color had CIE Lab, but atlas only had RGB colors.

On Mac, in browsers with display of number of files in directory, the numbers were cut off and poorly aligned.

In putting weave from editor to jacquard conversion, if we have weave block selected in jacquard conversion with 
extra wefts, but the decomposed inserted weave had just one point in single block, the weave was not inserted.

If you enabled print to file, landscape and mirror print were covered by print name options and were no longer visible.

Information about number of other files in browser was not always correct.

ArahPaint version 6.0.1530 to 6.0.1714

Enhancements

In font tool, added the following changes:
- maximum font height is now 999 and not 400
- added optional setting of font size in pixels instead of typographic points. In this way we can get fonts of any pixel 
size
- removed incorrect reporting of text size
- added support for aspect-ratio font rendering, if "Keep aspect" is enabled. This is implemented using "setStretch" 
function on fonts, but it only works on Linux in ArahPaint5, not on ArahPaint6. It is unclear if this is bug in Qt5, or 
calling functionality has changed. We need to test it on Windows and Mac to see it if the bug is platform related or a 
global regression in the toolkit.

Image browser now supports detail view, just like in ArahWeave. Added icon and list view icons, to enable switch 
between icon and list view in image browser. Added extra text fields to support list view in image browser.  Advantage 
with respect to ArahWeave is that it also allows changing of directories while in detail view.

Fix for disabling +- and other keys in numeric fields, so that zoom in/out shortcut can work even if numeric filed is 
active (for example, for pen size)

Added support for drawing rectangles and squares from center, the same way it works for circle.

Increased maximum second level grid from 30 to 100.
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Added reading of icon zoom from configuration file, so we know whether to use default icons or zoomed icons.

Improvements in text tool, font selection shows font preview, fonts are searchable, change from antialias and back 
shows correct preview.

ArahPaint6 now has autosave function. The time of autosave interval can be set in ArahWeave, Help > Save setup, 
Expert tab. You can also set it by editing the .arahne configuration file and setting
#AUTOSAVE_MINUTES=10
to the desired value. After a crash, or if restore to previous version of the image is desired afer closing the program, 
you can call
Files > Load automatically saved.
This will present a list of filenames with dates. By double click on list entry, you open the program's previous state. 
Layers should be maintained in the stored program state. The list interface also allows you to delete individual 
autosave entries, or all of them. Autosave stores up to 30 autosave images, then it stops overwriting the previous 
entries, to avoid filling up the disk.

Added toggle button for "Continuous saving" to Files menu. If we don't have any layers, if we are not drawing, if 
picture is modified, and picture is smaller than 3000x3000, then it gets automatically saved every second. Thus allows
interactive fabric simulation while drawing the image in ArahPaint, if "Instant conversion" is enabled in jacquard 
conversion in ArahWeave, and if same image filename is open in ArahWeave and in ArahPaint.

Increased maximum load/save image size dimension from 65520 to 262140.

Browse image icons can now be customized to desired size according to the settings in .arahne configuration file. For 
example:
#BROWSE_ICON_SIZE=150
If we also have ArahWeave, then browse icon size in Help>Save setup, Appearance tab.

Changed tooltip on directories in browser, so that it displays number of files or number of directories only if bigger 
than 0.

Added "preview" button to drawing in repeat dialog, which makes all operations in this dialog interactive.

Added display of number of other files, not images, in browse title.

Display of total number of images, files and directories in browse title was not equal as in ArahWeave. When we have 
filter in browser, do not display other information.

Bugs

Fixed missing translation for "points" in measure tool.

Fix for wrong display of selection in combination with crosshair cursor.

Default integer view status was correctly displayed in the interface, but it was not used, you had to enable/disable it 
twice in order for it to be come active.

Measure tool was drawing two lines instead of one.

Insert area was drawing double lines.

Fixed some too small icon sizes in drawing in repeat, insert/remove area, repeat layer.

Circle preview on rubber tool did not work

Mix tool preview lagged behind cursor

Fixed sorting in image browser by number of colors for true color, transparent and vector images.

Changed sort order in brush list, so that the newest brush is on the top. This is the desired behavior, and it is already 
working like that in ArahPaint4/5

Fixed EPS import so that the resulting resolution of rasterized vector image always matches the user interface value. 
Previously, integer DPI value was used, and this caused rounding errors and in some cases slightly different final pixel 
size.

Fixed wrong display of broken images which are not fully loaded due to image format problems (for example broken 
PNG). Before, program showed wrong icon, just random previous icon which was last calculated. Now it displays 
message in red "File corrupted!".

Changed icons for vector and folder in image browser.
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Fixed magic wand for alpha channel support. Previously, you could not select alpha channel. If you were selecting 
totally black area, the joining transparency was also selected. Now alpha channel works as fourth color component.

Averaging filter was not working on RGBA images.

Fixed crashing in ArahPaint6 multicore browsing during icon creation.

It load recent display had filename display without path enabled, then program did not display icon and extra image 
info in load recent.

The number of total files was wrong, it included number of directories.

On saving layer, the saved layer was not added to load recent.

Big optimization of memory usage in browsing on large number of images. Empty program was using 200MB of RAM 
for browsing 13.000 images, now it only uses 80MB of RAM for the same workload.

Added reading of .arahne configuration file parameter #DEBUG_BROWSE_OTHER_FILES, which enables printout of 
non-image files to console during browsing.

ArahDrape 3.0v to 3.2

Enhancements

In specifying labels to be drawn in the image, you can now use $N for new line, so the label will be split in two lines at 
that point. Only one new line is supported for each label. It is intended for users who use very long filenames, but still 
want to display all the information.

Increased maximum image size in ArahDrape from 32000 pixels to 65000 pixels.

Changed label in file selection box from "File search pattern" to "Filter", which is nowadays understandable.

In numeric text fields, you can use wheel mouse to change the numbers up or down. If you press Ctrl with wheel 
mouse, the change of value goes by 10 instead of 1.

In numeric fields with arrows, you can use wheel mouse to change the numbers up or down. If you press Ctrl with 
wheel mouse, the change of value goes by 10 instead of 1.

Changed the function for exchanging textures in mapping window so that Shift + left mouse button also exchanges, 
not Alt + Left mouse button, like it was before. We did this change so that Shift + Left mouse button will always 
emulate middle mouse button, that is exchange.

Added possibility to set custom color for titles. By default, text color in title printouts is black, but now you can set it to
a different color in Help > Save setup in Colors tab.

In toolbar of image browser, we now have a function with compress icon. This function will correct some bad PNG files,
which were saved with a previous incompatible version. It will also optimize the PNG file and make it smaller. JPEG 
files will also be made smaller. It has no effect on other files. Shortcut for this function is minus ("-"), since it will make
files smaller.

Modified the program so that the texture choice column on the right adjusts to icon size.

Load recent for models now used custom category just for models, not the same as general images. Normal images 
are rarely models, so it is better to keep them separated.

Bugs

If you had TIFF selected to print to an unsupported printer, the fields for print to file overlapped with the printer 
selection menu.

Alt+r was no longer working in image browser to toggle repeat view on icons.

For printers which do not have variable dpi (real printers instead of file formats), it was not possible to set the dpi 
setting other than the first one on the list.

When you first opened the program and it has no model loaded, browse model button was disabled, which was wrong.

Arahne load libraries

Enhancements

Improved reading of WIF files, so that it now reads files with repeat up to 8192x8192. Previously, it only read dobby 
files up to 40 shafts. So now we can misuse the dobby format to save jacquard files.
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If density in x and y is very different, more than 50 times, then probably the file reports wrong value. In that case 
ignore it and set it to 0, otherwise some client programs can be confused and crash (ArahPaint).

Added preliminary support for saving PDF files.

At the moment, only A4 image print size is supported, and images are scaled to full page.

PDF saving is implemented by external command, which converts JPEG into PDF without re-sampling, so it is small, as 
it only repackages the JPEG. 

Added controls that prevent loading of Staubli Delta 100/110/200 files as Takemura files, since both have .dat suffix, 
and Takemura does not have any file magic number at the beginning. If we find a file progNNNN.dat (where NNNN are 
numbers) we consider it to be Staubli Delta file and we do not load it.

Added support for reading Act .WJL dobby files, a Chinese dobby loom controller (Shaoxing Action Electrical and 
Mechanical Technology Co., Ltd.). Files were decoded using reverse engineering, so we can not be sure that all files 
load correctly. Most files appear to have up to 16 shafts and up to 16 weft colors. We do not have any files with 
regulator.

Added support for loading of 16 bits per channel TIFF RGB images.

Added support for reading BMP files in BMP version 2 format, that is OS/2 file format. Previously, only version 3 
(Windows 3.x) was supported.

Added extra checks in Tamerura .dat format, so that file size is also checked according to presumed weave size, and 
files which are too small are rejected.

Increased maximum loadable image size dimension from 65520 to 262140.

When testing dimension of Nuovo Pignone file, do not read the whole file.

Bug in reading of Nuovo Pignone file could crash the program, if last block was exceeding number of wefts.

Fixed reading of Adobe .ACO color palettes, where some palette values were read incorrectly, because we only took 
the upper byte instead scaling 65535 to 8 bits by dividing it by 256. So on some values, there was a 1 off mistake, 
which is not actually visible, but if you use exact palette RGB to identify the weave, it can be a problem. The extra 
information about ASO format was available on this site: Adobe Photoshop Color File Format 
http://www.nomodes.com/aco.html

Arahne print libraries

Enhancements

Added support for printing 1440x1440 dpi on Epson printers with GutenPrint driver.

Increased maximum printable image size dimension from 65520 to 262140.

Arahne icon libraries

Enhancements

Added numFiles to dirBrowse structure, so we now also track total number of files in a directory (also files which are 
not images). In this way we can display to the user number of images and number of files, so user can know that 
he/she has large number of non-images, which can cause slow directory access.

Increased maximum image size in icon creation from 65520 to 262140

Changed default icon size from 120 pixels to a variable, which can be set externally. Icon file format had to be 
changed in order to achieve it. Selected icon size is stored in the icon, and if default icon size is changes, icons need to
be recalculated.

Fixed icon preview of vector images for cases when vector image with default dpi is smaller than the icon size. We 
optimize creation of icons, so that we do not create icons for such small images, but rather load the image. But in case
of vector images, it is better to create the icon nevertheless, since reading of vector file is very time consuming. Also, 
reading of vector image uses external command, so reading it fails if called from the forked process, since the icon is 
created in the forked process, but then it was not saved, because image was too small.

But parent process then could not load the icon, since child process did not save it.

Bugs

In function countDirFiles, we were counting directories as files in some cases. Same problem also happened in sub-
directory browsing.
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